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Bonehead Directions 
Once upon a time, our manuals assumed that you knew how to run your Macintosh. 
Everyone here at Delta Tao is a longtime Mac snob, so we sneer at novices, at least 
behind their backs. 

If you don’t fall into the Novice category, skip ahead to the next chapter. You’re special! 
Or continue reading to remind yourself what it was like when you first got your Mac. 

So You’re a Bonehead. 
Big deal. We all were once. So what if the neighbor’s toddler in diapers knows her way 
around computers better than you? She can’t even say her name without drooling. 
Generation gap indeed! 

A lot of computer-challenged people get Eric’s Ultimate Solitaire. It, like Macintosh 
itself, is approachable. Once you’ve got it going, you can pretty much just drag the cards 
around with the mouse much like you’d drag real cards with your hands. 

We’ll try to address all your potential questions and problems here. But first, the single 
biggest trick to learning the Mac: 

Try it. 

That’s it. No matter how dumb you are, you pretty much can’t hurt your computer 
without overt physical action, like heaving a blender through the screen. It’ll confuse the 
heck out of you sometimes, sometimes so much you’ll fondle that blender and imagine… 
but don’t do it! 

Anyway, click everywhere. Pull down the menus. Hit all the buttons. Generally speaking, 
if it’s going to do something bad, the Mac is really nice about warning you. You can 
change your mind once you know the consequences.  

How do I make it go? 
Put the CD in your Mac and double-click the weasel icon. 

What’s a CD? 
It’s that shiny thing that came with this manual. No, not that. That’s the shrink-wrap. Get 
it out of your mouth! The round thing, inside the box. 

I found it. It seems to be in a case. 
Good. Take it out of the case (using excessive force if necessary), and put it in your Mac. 



It doesn’t fit. 
Please, please tell me you have a CD drive. Press the button by the CD drive. A drawer 
will open, with a hole perfectly sized to receive your CD. Put it in (shiny side down), and 
close the drawer. An icon of the CD will appear on your computer desktop. 

I see it! Now what? 
Double click the weasel icon. 

Double click? 
Click on it twice, quickly. You can also just click on it once and go to the “File” menu 
and choose “Open.” 

Hey, it’s going! 
Hooray. 

Do I have to put the CD in every time I want to play? 
No, but you can. You can also copy it to your hard drive. But that’s another chapter. 



Installing Ultimate Solitaire 
To install Eric’s Ultimate Solitaire, just drag its folder from the CD or disk image to 
where you want it.  Usually to your Applications folder is best.  

Potential Installation Problems 
We’re usually so brief that the above would be the whole explanation, but since we’re 
trying to fluff out the manual we’ll cover all the potential problems you may face in 
installing Eric’s Ultimate Solitaire X. 

I don’t have enough room on my hard drive. 
You can run Eric’s Ultimate Solitaire from the CD. This will launch and run slowly, but 
it’ll work. Consider buying a newer, bigger hard drive. They’re cool and cheap. As we 
write this, you can get a 200 gig drive for under $100. 

I can’t get the @#%$! CD box open! 
Tricky, aren’t they? The fat plastic part is the hinge, so open the other edge. Throwing the 
case at the wall sometimes works. 

I don’t have the CD. 
Maybe you just downloaded it from our web site. That’s usually a disk image file that 
will be named something like “Ultimate X.dmg”. Double-click it to mount it like a CD. 

If you used to have it, then it must have been lost somewhere, unless you’ve been doing 
some stupid software piracy where you copy the documentation instead of the software. 
Look for it. Maybe we forgot to put a disk in the package. Maybe it fell out. Maybe your 
dog ate it. (If you don’t have a dog, come and get ours.) If you can’t find it, call us, and 
we’ll gripe at you and send you a replacement for a few bucks. 

I don’t have a CD drive. 
Sheesh, get one. Or you can pass Ultimate Solitaire across the network with File Sharing 
or the like. Or you can just put the CD near your computer and hope that the information 
oozes across by osmosis. Or you can download Ultimate Solitaire from our web site. 

I don’t have a Macintosh. 
You’re starting to get tricky, now. Buy a Macintosh. You’ll like it. Or use the (not as 
good) PC version on the CD. 

I can’t read. 
You can too! Unless this is the audio-book version of the manual, as read by the author. 



The Ultimate Quick Instructions 
Here’s the one paragraph summary of what you need to know: 

Put Ultimate Solitaire on your hard drive. Run it. Figure the rest out 
for yourself — you’re smart enough, you’re good enough, and 
doggone it, people like you. 

Non-obvious stuff: 
cmd-Z to undo moves, cmd-R to redo, as often as you like. 

Hold down the shift key to see what cards you can play. (Dark shades are for the non-
obvious moves.) Choose “Darken Playable Cards” from the “Options” menu to do this all 
the time. 

Click a card to play it to what Ultimate thinks is the most obvious spot. Or toss it — grab 
it and give it a little flick. 

Hold down 2–9, T, J, Q, K, or A to darken specific ranks. Hold down C, D, H, or S to 
darken a whole suit. 

Hit the space bar to flip cards. 



About Eric’s Ultimate Solitaire 
When we decided to do Eric’s Ultimate Solitaire, we had two choices about how many 
games to include. 

1. We could include every solitaire card game known to man. There’d be several 
hundred games, and people would be amazed at our thoroughness, though (of course) 
there would be obscure ones we somehow missed. 

2. We could include a few of the very best games. We’d cover most of the major 
styles, and eliminate games that required little skill. 

We chose the second option. We picked twenty-five of our favorite games. Why twenty-
three? Because that’s how many fit in the menu on a normal Mac without scrolling. Good 
enough reason? Trust us, the game selection screen for choosing one of 200 possibilities 
isn’t pretty, or fun. 

The only game of the batch that doesn’t have a substantial element of skill is the one 
game we figure we have to have. Klondike doesn’t have very many decisions, but since 
it’s the single most popular solitaire game in the world, we put it in anyway. But really, in 
our humble opinion, it stinks. It requires little skill and you rarely win.  

Several games on here can be won almost every time. This doesn’t necessarily make 
them “easy.” Games like Towers can be tricky, even if they are winnable.  



What’s new on the X version? 
The previous versions of Eric’s Ultimate Solitaire are darned good. Ultimate X is more of 
a sequel than a new version. 

Our initial plan was to just add lots of new graphics, since we have lots of room on the 
CD. But it turns out we came up with lots of other changes. Here’s a partial list. 

New games. 
Double Klondike, Seven Off, and Eleven Off are all good new games. 

Graphics. 
There are dozens of cool new background pictures and patterns to choose from. Plus you 
can let Ultimate select them for you randomly. 

Bigger layouts. 
The old Ultimate was designed for a 640x480 screen, and it looked wimpy on a 19 inch 
monitor. This one looks great on 1600x1200 monitors. 

Requires OS X. 
If you’re still running System 7 or Mac OS 8 or 9, you can find our old version on the 
CD. 

New card faces. 
We made them bigger, more attractive, and easier to read. 

Even more statistics. 
Now you can find out how much you undo, how often you play Always Winnable games, 
and how much you cheat. 

Challenge games. 
You can save a game you’ve just finished, so you can have your friends take a stab at it. 
Find out who’s the better solitaire player. 

More sounds. 
More sound effects than the original. 

Cheating. 
Move cards around at your whim. 



The Options Menu 
Here’s a summary of the “Options” menu. 

Play Up 
“Play Up” tries to play up all the cards to the Foundations. Ultimate will move from pile 
to pile, checking to see if any cards can be popped up to the Foundations, over and over, 
until it can’t play any more. It isn’t real smart about this, but it does a fine job of finishing 
a game when it’s obvious. “Play Up” won’t ever move any card anywhere except to a 
Foundation, even if it looks obvious to you. After Ultimate gets done, if you haven’t won, 
you can keep going, or undo all the moves one at a time, or whatever. 

In some games there are plays to the foundation that you’ll always want to make — for 
example, you almost always want to play an Ace up, if you can. In these games, Ultimate 
Solitaire will Smart Play Up for you, so you don’t have to worry about it. In other games, 
though, it’s not a good idea to just unthinkingly play cards to the Foundations, so the 
decision is left up to you.  

Play Up does not try to play the hand for you, except in the final, and very simplest, 
stages. Most of the time, if you choose “Play Up” nothing will happen. Don’t be 
surprised. 

Cheat 
This moves a card you select from the bottom of its pile to the top, flipping it if 
necessary. Since anybody could win this way, Ultimate still marks the game as a loss in 
your statistics. So only do it as a last resort. 

Sound 
In a new and innovative user-interface move, we’ve decided to have this option turn the 
sound on and off. If it’s checked, sound is on. If it’s not checked, sound is off. 

To turn sound on when it’s off (and therefore unchecked), choose this menu item. 

To turn sound off when it’s on (and therefore has a checkmark by it), choose this menu 
item. 

You can also turn sound on and off (or change the volume) with the Sound Control Panel 
in your System Folder. 

Is it clear enough? Does everyone understand now what the Sound option does? It 
controls the Sound. 



If you still have trouble with the sound, call our Sound Help Hotline at 1-900-
MICROSOFT (only $5 per minute, plus toll, if any). Ask them about the cat. 

Choose Background 
Eric’s Ultimate Solitaire X comes with a bunch of background patterns, pictures, and 
gradients, all designed to be subtle and pleasing, so they don’t detract from the main part 
of the game. 

“Random” will give you a new background every game. 

Look at Statistics 
Ultimate keeps track of a ton of statistics, and you’ll get a chance to see them after every 
game. Of course, you can look at them any other time, too. 



Other Menu Items 
Preferences 

Each player has his own preferences, so when you switch players, Ultimate will switch 
whether you want flying cards, what backgrounds you like, and so on. 

Help 
This is where Ultimate lists the rules to the games. Sometimes there are subtleties that 
aren’t mentioned in the rules (like stack dragging in Towers), but the rules will at least let 
you get a quick grasp of the game. You’ll figure out strategies as you play. 

For strategy hints, see the strategy section later in the manual. 

Shortcuts 
We’ve provided a couple of shortcuts for various things in Ultimate Solitaire, This 
section will let you know about them. 

Hold down the shift key to see what cards you can play. (Light shades are for moves to 
any empty pile, where you can move any card. Dark shades are for less obvious moves.) 
Or choose “Darken Playable Cards” in the “Options” menu to do this all the time. 

Toss cards to their targets — it’s faster and easier than dragging them the whole way. 
You can also toss whole stacks, where applicable. 

Click a card to play it to what Ultimate thinks is the most obvious spot. 

Hold down 2–9, T, J, Q, K, or A to darken specific ranks. Hold down C, D, H, or S to 
darken a whole suit. 

Hit the space bar to flip cards. 



Glossary 
There’s a lot of terminology associated with solitaire, so it’s handy to have a list of funny 
words that might come up in the instructions. 

Column:  
A tall, skinny pile of cards. 

Delta: 
A Greek letter. To engineers, Delta means “change.” 

Deuce:  
A two. 

Foundation: 
The main piles you’re trying to build up. 

Packed Cards:  
A Column or portion of a Column that can be moved together as a unit. Packed cards are 
all the same suit, or alternating colors, depending on the game. 

Rank:  
The numerical value of a card. 

Reserve:  
Can be two things. In Canfield, it’s a pile of cards that you have to use to fill open spaces 
before you can use cards from the Stock. In Eight Off and Towers, the spaces where you 
put spare cards make up the Reserve. 

Stock:  
The deck. You flip cards from the Stock to the Waste Pile. 

Suit:  
Golly, some of these definitions are hard. It’s the suit — you know, the suit. Sheesh. Like 
Clubs, Spades, Double-Breasted, or Zoot. 

Tableau:  
The overall layout of the cards. 



Talon:  
The Waste Pile in Forty Thieves. 

Tao:  
Chinese word meaning the Path, or the Way. Pronounced DOW. 

Tau:  
Greek letter used by sophomoric fraternities. Don’t call us Delta Tau. 

Trey:  
A three. As in “Three of Clubs.” 

Waste Pile:  
Used cards that aren’t doing much good now. Typically only the top card of a Waste Pile 
can be played. 

Weasel:  
Smelly rodent that sleeps all day and works (or whatever) all night. 



Stuff About the Games 
This section includes the general rules for each game. 

In real life, nobody reads the rules. Just turn on “Darken Playable Cards” in the 
“Options” menu. Ultimate will show you which cards can be moved. Click on them. See 
where they go. You’ll figure the rules out pretty fast. 

If that doesn’t work, choose “Help…” from the “Options” menu. The directions there are 
as good as these, and they’re right there in the game. Who needs a manual, anyway? 

Alisa 
Object: Get rid of all the cards but one. 

Difficulty: Hard  Time: Medium    (Four Minutes) 

You can move any card onto any other card in the same row or column (not diagonally!) 
that matches either its suit or rank. The card played onto is discarded. 

Baker’s Dozen 
Object: Build the Foundations up, in suit, from Ace to King. 

Difficulty: Easy  Time: Medium     (Five Minutes) 

Build the Columns down, regardless of suit. Only the top card in each Column may be 
moved. You can’t fill spaces.  

Kings, by the way, are automatically sorted to the bottom of each pile. Otherwise Baker’s 
Dozen would be, as Eric says, “distinctly unfun.” 

Bristol 
Object: Build the Foundations up, regardless of suit, from Ace to King. 

Difficulty: Easy       Time: Pretty fast (Four minutes) 

Suit doesn’t matter at all in this game. Build Columns down regardless of suit. Cards are 
flipped from the Stock 3 at a time, one to each Waste Pile. You can’t fill spaces. 

Calculation 
Object: Build the Foundations up as follows, regardless of suit: 

Difficulty: Very Hard    Time: Slow        (Ten minutes) 



A,2,3,4,5,6,7,8,9,10,J,Q,K (by 1) 

2,4,6,8,10,Q,A,3,5,7,9,J,K (by 2) 

3,6,9,Q,2,5,8,J,A,4,7,10,K (by 3) 

4,8,Q,3,7,J,2,6,10,A,5,9,K (by 4) 

Suit doesn’t matter at all in this game, either. Cards from the deck may be played to any 
Row (regardless of suit or value) or to a Foundation. Only the rightmost card of each 
Row is available to be moved to the Foundations. 

Canfield 
Object: Build the Foundations up, in suit, wrapping from King to Ace as necessary.  

Difficulty: Hard             Time: Slow (Six minutes) 

Flip cards three at a time to the Waste Pile. Build the Columns down in alternating colors. 
You can move stacks to other Columns. You can move the top card of any Column or the 
Waste Pile to a Foundation. If a Column empties, it’s filled with a card in the Reserve. 
There are unlimited redeals. 

Carpet 
Object: Build the Foundations up, in suit, from Ace to King. 

Difficulty: Very Easy       Time: Very Fast   (One minute) 

You can play any card in the “carpet” up to the Foundations — in fact, this will be done 
automatically as long as the “Smart Auto Play” preference is on. Turn the cards up one at 
a time to the Waste Pile. You can use the top Waste Pile card to fill spaces in the carpet. 

Casino  
Object: Build the Foundations up, in suit, from Ace to King. 

Difficulty: Hard  Time: Medium (Five Minutes) 

This version of Klondike lets you go through the deck one card at a time. Unfortunately, 
you only get to traverse the deck once. 

Traditionally, you pay $52 for the deal, then you get $5 back for every card you play to 
the foundations. Our version may be a tad easier than that found in the casinos, so if you 
find yourself winning don’t run off to Vegas to make a fortune too fast. 



Double Klondike (Two Decks) 
Object: Build the Foundations up and in suit, from Ace to King. 

Difficulty: Medium            Time: Long (Ten minutes) 

This is the double deck version of Klondike, and has the same rules. Get good at 
Klondike before you progress to this one — it’s got the same tricks, but you have to think 
farther ahead and plan more. And it takes a lot longer. 

Eight Off 
Object: Build the Foundations up and in suit, from Ace to King. 

Difficulty: Easy             Time: Fast (Two minutes) 

Build Columns down and in suit. You can play the top card in any Column or the Reserve 
to a Foundation, Column or Reserve. Empty Columns may be filled with any card. 

You can have up to 8 cards in the Reserve. 

Note: You can’t move packed cards as a unit unless you have enough empty spaces to 
unstack and restack them. 

Eleven Off (Two Decks) 
Object: Build the Foundations up and in suit, from Ace to King. 

Difficulty: Medium            Time: Medium (Seven minutes) 

This is the double deck version of Eight off, and has the same rules. Get good at Eight 
Off before you progress to this one — it’s got the same tricks, but you have to think 
farther ahead and plan more. And it takes a lot longer. 

Forty Thieves (Two Decks) 
Object: Build the Foundations up and in suit, from Ace to King. 

Difficulty: Hard             Time: Slow (Twelve minutes) 

Build Columns down and in suit. The topmost card in any Column and the top card of the 
Waste Pile (popularly called the “Talon”) can be played to a Foundation or Column. 
Empty Columns may be filled with any card. You may flip cards off of the deck onto the 
Waste Pile any time. There is no redeal. 

Sometimes the Talon gets scrunched, and it’s hard to tell what the cards are. You can 
click and hold on any card in the Talon to pop it up so you can read it. 



FreeCell 
Object: Build the Foundations up, in suit, from Ace to King. 

Difficulty: Medium Time: Medium     (Five Minutes) 

Build Columns down in alternating colors. Play any card to an empty space 

Note: You can’t move packed cards as a unit unless you have enough empty spaces to 
unstack and restack them. 

Golf 
Object: Leave as few cards as possible remaining in the Columns. 

Difficulty: Hard        Time: Pretty fast (Two minutes) 

7 Columns of 5 cards each are dealt to begin the game. Choose any card from a Column 
to start the single Foundation. Build the Foundation up or down regardless of suit. Kings 
wrap to Aces. Play the top card of any Column to the Foundation. 

When play comes to a standstill, flip a card from the Stock. There is no redeal. 

Klondike 
Object: Build the Foundations up and in suit, from Ace to King. 

Difficulty: Medium            Time: Medium (Three minutes) 

Flip cards three at a time to the Waste Pile. Build Columns down in alternating colors. 
Packed cards may be moved as a unit to another Column. Partial piles are OK to move, 
too. 

You can move the top card of any Column or the Waste Pile to a Foundation. You can 
only fill spaces with Kings, or piles with Kings on the bottom. There are unlimited 
redeals. 

Montana 
Object: Get cards into sequence (2 to King) in suit from left to right. 

Difficulty: Hard            Time: Medium (Six minutes) 

Play a card into a space if it’s the same suit and one higher than the card to the left of the 
space. Play deuces to any open space on the left edge. There are two redeals. Use 
“Darken Playable Cards” with this game; it helps a lot. 



Poker Square 
Difficulty: Medium            Time: Medium (Three minutes) 

Object: Arrange the cards into poker hands to get the maximum number of points. A 
“win” is any game that you get at least 200 points. Swap cards to maximize your score. 

Ultimate adds up the 5 vertical and the 5 horizontal hands. 

10, J, Q, K, A of the same suit. 

Royal Flush   100 
Five consecutive cards in the same suit. 
Straight Flush   75 
 
Four of a kind   50 
Three cards of one rank and two of another. 
Full House   25 
Five cards in the same suit. 
Flush   20 
Five consecutive cards of any suits. 
Straight   15 
Three of a Kind   10 
Two Pair   5 
One Pair   2 
Nothing   0 

Pyramid 
Object: Eliminate all the cards by getting rid of pairs that add to 13.  

Difficulty: Medium Time: Medium     (Five Minutes) 

Queens (12) pair with aces (1), Jacks (11) pair with deuces, and Kings (13) are eliminated 
all by themselves. 

You can go through the deck three times. All the cards have to be eliminated — not just 
the ones in the pyramid. 

Seven Off 
Object: Build the Foundations up and in suit, from Ace to King. 

Difficulty: Medium            Time: Medium (Five minutes) 



This is a harder version of Eight off, and has the same rules. Get good at Eight Off before 
you progress to this one — it’s got the same tricks, but you have to think farther ahead 
and plan more. 

Spider (Two Decks) 
Object: Remove all cards from the Tableau by building all eight sets of cards from King 
to Ace in suit. Move completed sets up to the Foundations. 

Difficulty: Very hard        Time: Very slow  (Twelve minutes) 

Build Columns down, regardless of suit. You can move the top card of each Column, as 
well as all packed cards that are of the same suit.  

When play comes to a standstill (or sooner if you want), click the deck and Ultimate will 
deal a card from the deck to each Column. You can fill spaces in Columns with anything. 

Spiderette 
Object: Remove all cards from the Tableau by building all four sets of cards from King to 
Ace in suit. Move completed sets up to the Foundations. 

Difficulty: Very Hard             Time: Slow (Five minutes) 

Build Columns down, regardless of suit. You can move the top card of each Column, as 
well as all packed cards that are of the same suit.  

When play comes to a standstill (or sooner if you want), click the deck and Ultimate will 
deal a card from the deck to each Column. You can fill spaces in Columns with anything. 

Three Shuffles 
Object: Build the Foundations up, in suit, from Ace to King. 

Difficulty: Medium Time: Medium (Five Minutes) 

Build rows down in the same suit. Reshuffle and redeal when play comes to a standstill. 
Once during the game, you can grab a card from anywhere in the tableau and use it. 

Towers 
Object: Build the Foundations up and in suit, from Ace to King. 

Difficulty: Medium            Time: Medium (Four minutes) 

This game’s a lot like Eight Off, except you only have 4 cards in the Reserve, and 2 of 
them are full at the start. Build Columns down and in suit. You can play the top card in 



any Column or the Reserve to a Foundation, Column or Reserve. Empty Columns may be 
filled only with a King. 

Note: You can’t move packed cards as a unit unless you have enough empty reserve 
spaces to unstack and restack them. 

Westcliff 
Object: Build the Foundations up and in suit, from ace to king. 

Difficulty: Easy       Time: Pretty fast (Two minutes) 

Build Columns down in alternating colors. All or any cards in a Column may be moved 
as a unit to another Column. You can move the top card of any Column or the Waste Pile 
to a Foundation. You can fill spaces with anything. There is no redeal. 

Whitehead 
Object: Build the Foundations up, in suit, from Ace to King. 

Difficulty: Easy  Time: Medium (Four Minutes) 

Build piles down in the same color. You can move packed cards in the same suit as a 
unit. 

Yukon 
Object: Build the Foundations up in suit from Ace to King. 

Difficulty: Medium            Time: Medium (Seven minutes) 

Build piles down in alternating colors. Nothing plays on an Ace. You can move any card 
in any Column, no matter how deeply buried — all the cards covering it get moved right 
along. Only Kings go in an empty space. 



Eric’s Strategy Tips 
This is a collection of simple strategies we use to win the games in Ultimate.  

Alisa 
The key is to not leave cards stranded. If a card is the only one in its row or column, 
you’re never going to get it out. Avoid this by keeping multiple options open for each 
card, where possible. And hop cards toward the group. 

Baker’s Dozen 
The main problem in Baker’s Dozen is when a higher card of a suit is on top of a lower 
card of the same suit. For example if the 3 of clubs is on top of the 2 of clubs then at 
some point during the game you’ll have to straighten that out. Once you straighten out 
these problems things should go easily. Don’t build one foundation ahead of another. 
This could limit moves later in the game. 

Bristol 
A very easy game once you get the knack. Dig down to the last card in every pile, but 
don’t move that card — it would kill the pile. Don’t “Play Up.” 

Calculation 
Plan ahead which cards can be stacked in order. If you can make a pile with six, eight, 
ten, and queen in order, they will all play up nicely on the “two” pile eventually. 
Likewise nine, ten, jack, and queen are a good set to have near the top of a stack, since 
they play late on the “one” foundation. Leave one pile available for undesirable cards 
such as kings, which you know won’t be playable until the very end. Think ahead of the 
sequence on all four piles, so you can best decide where to put a card that may be played 
on multiple foundations. 

Canfield 
Try to empty the reserve as soon as possible. Be careful about playing cards to the 
foundations — don’t build one foundation more quickly than another. Try to play all the 
cards of a rank before the next rank. i.e. Play the threes and then the fours. 

Carpet 
Play low cards to the empty spaces. Don’t fill spaces with high cards. Make sure “Auto 
Play Up” is on. We like to play “Speed Carpet.” The fastest win we’ve had is 11 seconds. 



Casino  
It doesn’t pay to stall playing cards as often as in real Klondike, because you only get to 
go through the deck once. 

Eight Off 
Try to play the aces up to the foundations as soon as you can. It’s best to clear out entire 
columns if possible. The more open spaces you have, the longer stacks you can move. 
We like to play “Speed Eight Off” where the goal is to see who can win in the shortest 
time. Our record is 15 seconds. 

Forty Thieves (Two Decks) 
Try to get a space as soon as possible. Pick a pile that looks promising. Don’t make plays 
that would use up the spaces that the cards from this pile would go to. If the pile has a 3 
of clubs in it then try not to play the other 3 of clubs on a 4 of clubs. Save it for the 3 of 
clubs in our chosen pile. Just because a play can be made doesn’t mean it’s a good idea. 
Only play cards up if there’s a good reason to do so. 

FreeCell 
This game is similar to Towers, except you can play any card to an empty pile, not just 
kings. Also, since it alternates red and black it’s much easier to unstack large piles than in 
Towers. 

Golf 
Plan your moves ahead. Try to save queens so that you can remove kings with them. Try 
to leave sequences of cards after a move. 

Klondike 
Klondike is a hard game. Try to uncover cards in the tableau as soon as you can. Don’t 
build up one foundation more quickly than another. Try to play all the cards of a rank 
before the next rank. — play the threes and then the fours. 

You may find it helpful to save plays early in the deck until a later time through the deck. 
This maximizes the cards you make available for play. 

Montana 
Find a move that you’d like to do and then see if it’s possible. If you want to move the 2 
of clubs into a space on the left, check what card is in that space. Let’s say it’s the 7 of 
diamonds. Then look for the 6 of diamonds. With luck there’s a space to the right of it. 
Then you can just move the 7 there and move the 2 of clubs into position. If not then you 
have to keep looking. If the 9 of Hearts was in that spot then we’d look for the 8 of 



Hearts… This method of looking for moves is slow but works well. It’s also good for 
getting rid of dead spaces. Just look for the appropriate Queen and look for a sequence of 
moves that will let you move the King next to the Queen. 

Don’t forget that you can find a playable card by clicking on an empty space. 

Poker Square 
Most people line up flushes horizontally and try to make four of a kinds and full houses 
vertically. Many deals will give you four flushes. Most of your points will come from full 
houses. 

Don’t bother making straights in most cases.  

Straight flushes are worth many points. Every straight or straight flush has a 5 or a 10 in 
it. 

Pyramid 
You have to eliminate the whole deck, and not just the pyramid, so you may have to skip 
a playable move to save a card to eliminate a pesky card elsewhere in the deck. 

Spider (Two Decks) 
Empty piles are the key. One empty pile is good. Two and victory is almost assured. Use 
the Undo feature judiciously. Explore the piles. Go out of your way to play suited cards 
on each other. Avoid uncovering aces — once an ace is up nothing can ever be played on 
that pile again. 

Spiderette 
Use the same strategies as Spider. Spiderette is even harder. 

Three Shuffles 
The key to the game is judicious use of the “Draw.” 

Towers 
Keep your empty spaces — try not to play cards to them unless you’ll be able to play 
them back down again afterward. Don’t bury a small suited card too deep with larger 
cards of the same suit, or you won’t be able to uncover it. Almost every game of Towers 
is winnable, if you’re good. 

Westcliff 
Easy. You’ll win. Usually you’ll want to dig into shorter stacks first. 



Whitehead 
Like in Klondike, it makes sense to postpone plays early in the deck to maximize your 
chances at hitting other cards later on. 

Yukon 
Like Klondike, it’s a good idea to uncover the face down cards as soon as you can. Don’t 
bother building up the foundations unless it’ll help you play more cards in the tableau. 
Well, ok, if you’re going to win then it’s ok to play cards up… As usual, don’t build up 
one foundation more quickly than another. This could doom you later in the game. 

John’s Secret Strategy: Turn on “Darken Playable Cards” and keep clicking on the 
darkened cards. You don’t even have to know the rules to win. 



Stack Dragging and Towers of Hanoi 
Some of the games (Eight Off, Towers, FreeCell, and Forty Thieves) sometimes will let 
you move a whole stack. Sometimes it won’t. What’s the deal? 

In these games, the rules say you can only move one card at a time, so you can, according 
to the rules, never move a stack. 

This is similar to the ancient puzzle game Towers of Hanoi, in which you move different 
sized disks (corresponding to different ranked cards) among some number of pegs. 

But it turns out that when there are empty spaces, you can effectively move more than 
one card in a stack at a time. 

If you want to move a stack including a packed 6, 5, 4, 3, and 2, you need four empty 
spaces, so you can move the 2, 3, 4, and 5 down, then move the 6 across, then move them 
back up. Ultimate is so smart it lets you skip the middle steps. 

Play with it and you’ll see what’s going on. Or just trust us and use the shift key to show 
you which stacks can be moved. The more open spaces you’ve got, the deeper a pile you 
can drag at once. That’s what’s important. 



Multi-Player Solitaire 
Come on, now. Solitaire is for one player, by definition. Like “solitary,” or “solo,” or 
“solicitor,” or “Solarian.” If you played it with two people, it would be “Duotaire,” or 
something. 

Some people call solitaire a “patience game,” or a “game of patience.” We didn’t want to 
call it anything like that, for fear people would confuse us with Sierra Online’s Hoyle’s 
Book of Games, which really takes patience. 

The best way to compete is to save your completed games as Challenge Games. Then you 
can have your opponent try the very same game you just did and you can compare how 
you did. 

Another way is to compare your statistics to theirs. You can say, “Ha! I have a higher win 
percentage than you in Forty Thieves!” They’ll be impressed, or annoyed, or both. That is 
what you wanted, right? 



Common Problems 
We don’t get very many calls from this game — it’s easy and nearly flawless. 

I crash all the time. 
Don’t look at us — our software never crashes. It must be somebody else’s fault. On the 
other hand, if you do find a reproducible crasher, call and tell us about it so we can fix it 
in later versions. 

My statistics aren’t changing. 
Challenge games don’t count in your normal stats. Anybody can win those! 

I keep getting the same deals. 
The demo version of Eric’s Ultimate Solitaire X is limited to only a few of each game, 
and then it repeats. 

Sometimes I can drag stacks, and sometimes I can’t. What’s the deal? 
In many games, like Towers, Eight Off, Forty Thieves, and FreeCell, the rules say you 
can only move a single card at a time. But if you have empty reserve spaces available, 
you can unpile stacks and move a group. Ultimate is friendly, so it lets you skip 
intermediate steps. Read “Stack Dragging” here in this manual for more information. 

Some of my cards are dark. I don’t want to cheat! 
You have “Darken Playable Cards” turned on. It’s not cheating, but you can turn it off in 
the “Options” menu. 

The weasel isn’t talking. 
Odds are you have the “Weasel Voice” option unchecked in the preferences. Choose 
“Preferences…” from the “Options” menu to fix it. 

My card backs got all wacky today. 
Hmmmm. What’s special about today? Could it be a holiday? 

I have trouble throwing cards. 
Practice, practice, practice. Start out with the hat just a few feet in front of you, and then 
move it back a few inches after every deck. Make sure you put enough spin on the cards 
to keep them from just fluttering about aimlessly. 

Of course, on the computer, the cards will home in right where you want them. Most of 
the time, anyway.  



What are the secrets of the game? 
If we told you, they wouldn’t be secrets, would they? So don’t ask us. Figure them out for 
yourself, if you must. 

Please? 
No! They’re secret! 

Please? 
OK, maybe a couple. Play on holidays. Turn on balloon help and point to various cards. 
Create a player named “Weasel.” Send us a hundred bucks. 

My boss is coming — Help! 
If you hold down the option key and click on the computer desktop, Ultimate will be 
instantly “hidden.” You can get it back by choosing it from the dock at the bottom of 
your screen.  

Or just hit cmd-Q — Ultimate quits fast. 



Technical Support 
We think the single most important thing a software company provides (other than 
software) is Technical Support. We pride ourselves on being able to solve virtually any 
problem one might have with Ultimate Solitaire, and lots of other problems as well. If 
you call us directly at (408) 730-9336 at reasonable California business hours and ask for 
tech support, we’ll be happy to help you with anything we can. It’s also possible that you 
can get us at unreasonable hours, since we work hard and late, but we can’t guarantee it. 
If you want alert, friendly service, don’t call early in the morning. And remember, it’s 
three hours earlier on the west coast than the east. 

8032 Twin Oaks Ave. Citrus Heights, CA 95610 
Keep in mind that we’re understaffed, overworked, and appreciate brevity. If you can 
answer questions like “What version of Mac OS X are you running?” without checking, 
we’ll be ecstatic. If you call with questions like “What’s a Macintosh?” we’ll be peeved. 
Okay? 

(408) 730-9336 or help@deltatao.com  
We love getting questions and comments via e-mail. Check out our website at  

http://www.deltatao.com. Send an email to Joe (the prez) at joedelta@deltatao.com. 

Our Mailing List 
You can subscribe to the Delta Tao e-mailing list. Send an email to “deltataonews-
subscribe@yahoogroups.com”. 

That’ll keep you up to date, with news of our new products, strategies, questions and 
answers, and various propaganda. We don’t sell our mailing list to anybody, and we only 
send maybe one message a month. 

Our Web page: 
http://www.deltatao.com 

Eric’s Web page: 
http://www.sniderware.com 

Joe’s Web page: 
http://www.joedelta.com  



Future Directions 
Ultimate Solitaire is likely to go through some revision over the next couple of years, but 
it will strive to continue to be simple and fun. We welcome suggestions — many things 
suggested by early users are now in the game. We’re more likely to do suggestions that 
make things simpler and more fun. 

The best way to give us suggestions is in writing. When you talk to us on the phone, your 
comment has to get translated too many times before it gets to the programmer for him to 
know what the suggester had in mind. 

Go ahead, list your favorite solitaire games that we didn’t include. If there are a couple 
that we keep seeing over and over, maybe we’ll put them in a later version. If they’re fun. 
Tell us which ones you don’t like, too. Maybe we’ll pull them out. 



About Eric Snider 
Eric always hoped he could goof around and write games for a living like his oldest 
brother (David, who’s the author of some incredibly popular Apple II programs, 
including David’s Midnight Magic, Serpentine, and Dazzle Draw) and it looks like his 
dream has come true. He also managed to squeak his name into the title of his first game 
— a family requirement. 

Eric spends twelve to fourteen hours every day on the Net. You can increase this time by 
writing directly to him at eric@sniderware.com. He likes that. Ask him about his 
chickens. 

What’s with the Weasel? 
Most of the work that went into Eric’s Ultimate Solitaire X had to do with the user 
interface. We’ve made a fast, simple game that’s got the very best time-wasters ever. 
We’re convinced that after playing Ultimate, you won’t be able to stand any other 
solitaire game. We’ve got a lot of really cool, highly addictive features. 

However, we were stumped for a long time about what art to use. We could have put a 
big picture of a card on the box. Oooh. Exciting. Or we could have used a photo of a 
satisfied customer. We could even have used a picture of a big block of cheese — it 
worked once. 

But we used a weasel. It’s Eric’s mascot animal, his familiar, his totem. And now he’s 
with you every step of the way, exhorting you to victory, sympathizing with your losses. 
He gives you that goofy, cross-eyed smile from the About Box, and graces the front 
cover of the manual. He’s everywhere. 



Thanks! 
Tons of people contributed to Eric’s Ultimate Solitaire X. They hammered the game 
through over a year of development. They pointed out every little flaw, and selflessly 
crashed their machines dozens of times helping us make a cooler, better game. 

These aren’t all the people that helped. No doubt a few were inadvertently forgotten, or 
we couldn’t figure out how to spell their names, plus there are a couple that we just plain 
intentionally snubbed. 

Robert Roosevelt wrote the OS X version and listened to hundreds of eager suggestions 
from fans. 

Drew Olbrich drew most of the patterns and was really picky about the interface. 

Tim Cotter helped find all the little problems that everyone else missed. He also wrote a 
lot of the Ultimate shell code. 

Peter Commons helped with a bunch of stuff — especially when Timmer was busy. 

Dean Yu contributed the window zooming code.  

Doug Couchman pointed out lots of problems with layouts on PowerBooks and found the 
bugs in Spider. 

Mike Darweesh convinced Eric to release his first shareware. 

Mary Williams nitpicked the manual and kept Joe from going crazy. 

Dan Appelquist tested Ultimate and did the art for Eric’s shareware games, which got 
him into this crazy Ultimate Solitaire stuff in the first place. 

Butch Anton did lots of testing and helped us afford our development Macs. 

Kate Cremer organized the manual so it made a little sense. 

Tim Dierks fixed most of the bugs that were too baffling for Eric. 

Steve Bollinger helped with prefs file stuff and a ton of other things. 

Steve Falkenberg helped out with the prefs file stuff. 

Jang Chun was Eric’s roommate when he first started Ultimate, and helped with figuring 
early stuff out. 



Art Cabral introduced us to Towers with his excellent shareware game, Seahaven 
Towers.  

Christie Cooper tested Ultimate and proofread the manual. 

Maria Fischer tested things out before anyone else while Eric was still at Carnegie 
Mellon.  

Derek McCaw took the time and care to record all the great sound effects. And the whole 
Mumblypeg gang gave us something cool to fill our CD. 

Dr. Sheila Greibach solved the pile dragging math problem for Towers of Hanoi. 

Andy Plotkin solved the equations for parametric cubic splines, since Eric couldn’t figure 
it out himself. 

Alisa Scherer inspired the game “Alisa,” and tested the game unmercifully. Also, she 
didn’t make fun of the TaoHouse boys for wearing pirate costumes to her (and Timmer’s) 
wedding. 

Larry Kwan and Brian McGhie got Eric’s Solitaire Sample on the System 7.5 CD, 
making us all famous. 

John Speck didn’t do anything. At all. Well, he came up with a ton of great ideas that we 
used and later forgot to give him credit for. Plus he invented the word “Intellitaire™” and 
saved the day on the back of the manual. 

Nancy Williams proofed the manual and insisted on more and more (and more!) pictures. 

Jennifer Craythorne helped test things out, encouraged Eric to read more, wrote some 
fabulous letters, and didn’t complain much when Eric stayed up late working on 
Ultimate. She also ate Eric’s (yuk!) mushrooms and laughs at his jokes. Somebody has 
to. 

Alexandria Thompson helped with testing and got Cliff Johnson’s phone number. 

Joe Britt gave Eric his radio antenna because someone stole his receiver and because he’s 
nice. 

Howard Vives did all the artwork and made Eric’s work more fun. 



Joe Williams let Eric write this game, had lots of interface ideas, and made lunch pretty 
often. And other stuff too. And, of course, he wrote the manual. [And he’s a great human 
being — Ed] 

David Snider tested stuff and gave Eric the idea that he could make a living writing cool 
software. 

Eric’s Mom & Dad did a bunch of testing and handled the tons of mail that comes to 
Michigan because of Eric’s shareware. And if they hadn’t bought Eric an Apple II when 
he was 9, he’d probably be doing something different today. 



The History of Delta Tao 
Delta Tao was born in 1989, when Joe Williams and Tim Cotter (“The Amazing 
Timmer”) tired of complaining about the high price and low quality of software and 
decided to do something about it. They wrote Color MacCheese, the first affordable color 
paint program — $49 when its closest competitor was $599. When Color MacCheese 
sold lots of copies, we took the plunge and dedicated ourselves to starting a little 
company to write Mac software. 

Many people asked, “Why Delta Tao? Sounds like a fraternity.” There is a reason. 
“Delta” is the symbol used by engineers around the world to signify change. One would 
say “Delta V” when he means “change in velocity.” We admit this is engineerspeak, but 
forgive us for a minute. We’re mostly engineers, so this makes sense, at least to us. 

“Tao” (pronounced DOW) is a Chinese word that means “the Path,” or “the Way.” It is 
the big concept behind Taoism. We’re mostly Taoist sympathizers around here, so this 
made sense too.  

When you put these together, “Delta Tao” means “The Changing Path,” or “The Change 
in the Path.” We thought that this was almost a profound statement of direction, so we 
adopted it as a name. 

We want to stifle all rumors right now that this name may have evolved in any way from 
the name of our college “fraternity,” Delta Tau Sigma (at Caltech, if you must know). All 
such statements are unfounded, and any similarity in the names is coincidental. Any 
references to a Mr. Dan Schwartz are also hereby disavowed. Also, it has nothing to do 
with Animal House frat “Delta Delta Tau,” or because we wrote Color MacCheese in 
Delta Junction, Alaska. These things are just coincidence. Really. 

Delta Tao (now expanded to include Eric Snider, Peter Commons, Howard Vives, 
Christie Cooper, John Speck, Bob Van de walle, Paul Toth, and several others) is out to 
convince people that computers and technology are important, fun, and useful tools that 
can change the way the world works for the better. We believe that the Macintosh is the 
greatest computer on the planet, so we’re focusing on writing cool Mac software. Like 
games. 

We’re tired of certain other computers having more, better games than the Macintosh. 
We hate seeing ports from other systems dominate the Mac game market. This takes 
away from the Mac’s biggest advantage — the user interface. Instead of just using our 
standard Mac stuff, we have to put up with the varied and difficult user interfaces those 
other computers have. 



We love the Mac, and love computer games, so we bite the bullet and write great games 
for the Mac. Even if our games don’t make us a huge profit (and they don’t, trust us), 
they need to be done, just to spur the Mac into the homes, where it belongs. Besides, we 
want to play them. 

Someday we hope to be famous. 
Since we don’t do much of anything in the way of marketing or advertising, we depend 
on word of mouth. That means we want you to do our advertising for us. Tell all your 
friends how great our products are. Call up local software and computer stores and ask 
them to carry our stuff.  

Call us and tell us the names of your local software stores, so we can nag them from our 
end. 

We also like encouragement. Surprisingly, none of us is making a huge fortune in the 
software business. Yet. We do it because it’s fun, and because we like to believe we’re 
making the world a happier, better place. Send us a letter telling us if you think we’re 
cool. Chat with us via e-mail. Invite us to dinner. We love that stuff. 

Yeah, we know we’re the only software company in the world that thinks “customer 
support” works this way. But we deserve it.  



Delta Tao Frequently Asked Questions 
We’re a bunch of engineer types who like to sit around writing games. This amazes 
everybody: Half ask, “How can they make a living doing that?” and the other half ask, 
“Why would anybody want to?” 

How many of you are there? 
Between three and twenty, depending on how you count us. Five is a fair guess. 

Do you work out of your house? 
Yep. Each of the programmers has an office in his house, and the phone-answering, 
testing, and frenzied partying happens at TaoHouse. 

Are you guys rich? 
Spiritually. We make a quarter the money as we would working for a real company, but 
we have four times as much fun, which makes up for it. 

Are you guys a cult, or a fraternity, or what? 
We prefer “fraternicult.” 

Nah, really we’re just nerds with a mission. 

Mission? 
Proving computers are fun. 

Is that a lawyer behind you? 
Oh, I meant, “Proving Computers are Fun™.” 

Why do you like Macs so much? 
It’s been proven statistically that Macs are more fun, as demonstrated by the SSR — the 
Smiling/Swearing Ratio. Mac users have an SSR of 11.7, while Windoze users are more 
along the lines of 0.04. And this number is generally agreed upon in the industry, despite 
the fact that I just made it up. 



Mumblypeg 
CDs hold a lot of stuff, and even after we stocked it full of everything we could think of, 
we still had lots of room left over. So we made it into a cool comedy audio CD, too. Just 
put it in your normal CD player and you’ll hear the soothing strains of Mumblypeg, our 
favorite comedy troupe. They’re defunct now, but still cool. 

In their own words: 
To find out what’s up with the ’Peg, contact mumblymail@aol.com, or check out their 
web page: http://www. mumblypeg.com. 

“We founded Mumblypeg in 1993 to explain our spending too much time together. Since 
then, Mumblypeg has entertained audiences throughout the San Francisco Bay Area and, 
oddly enough, Texas with our blend of sketches, music, and improvisation. 

“The disk holds a sampling culled from several live performances. At this writing, We’re 
not sure exactly what’s on it, but pay careful attention to the subtleties of Track 1, a little 
piece we like to call Annoying Buzzing Noise That You Should Just Skip Over, Unless 
You Own a Macintosh, in Which Case, It’s Probably Why You Bought This. 

 “In no particular order, special thanks go to: Skye Taylor, Tim McNerney, Joe and the 
gang at Delta Tao, Trafor Productions, The Dead Alewives, The Bert Fershners, Jeff 
Kramer, all the moms, Ross Nelson, Heather, Élan, Mike, David, Cindy, and everyone 
who has ever paid attention to us.” 



Our Stand on Copy-Protection 
We at Delta Tao think that copy-protection is an evil thing that could damage the growth 
of the software industry and the computer industry as a whole. We hope you’ll boycott all 
copy-protected products. Here’s why. 

We believe people have a certain amount of money to spend on software. After they blow 
their software budget, they still want more software. If copy-protection is preeminent, 
they are out of luck. The software they buy is the only software they have. They find their 
Macintosh less useful, and don’t encourage their friends to buy one. The hardware and 
software industries dwindle and die. 

On the other hand, if things aren’t copy-protected, people pirate software once they’ve 
blown their software budget. They learn which programs are good and useful first hand. 
The next year they will make informed decisions about what software to purchase. In the 
meantime, they find their computer more useful and friendly. They recommend it to their 
friends, who go on to become software purchasers. 

There are two problems. Number one, in a world where some programs are copy-
protected and others aren’t, people may buy copy-protected software (since that’s the 
only way they can get it) and pirate the unprotected software. This rewards the businesses 
who are damaging the industry, and punishes those who help it along.  

Number two, publishers without copy-protection can’t sell bad software with massive 
advertising. Since people tend to try software before they purchase it, companies only sell 
their products to people who find it useful. This means companies with inferior products, 
but big budgets, adore copy-protection. 

We don’t mind problem number two so much, but the first problem scares us. The 
solution: boycott copy protection. Make sure it isn’t profitable to copy-protect software. 

Before the Software Publisher’s Association has us lynched (they claim that “billions of 
dollars of revenue are lost every year to piracy”) we’ll invent at least a little bit of 
evidence for our theory. Remember back when the cassette tape was invented? People 
could now copy records indiscriminately, and there was nothing the record company 
could do about it. “We’re doomed!” they shouted. “Now we’ll only sell one of each 
record!” What really happened? The music industry took off to previously unimaginable 
levels, generating more profits for more artists than ever before. 

When VCRs were first available, people could copy movies indiscriminately, and there 
was little the movie companies could do about it. “We’re doomed!” they cried. “Now 



we’ll never sell another movie!” What happened? The movie industry took off to 
previously unimaginable levels, generating more profits for more people than ever 
before. 

Pay for software based on its quality, not its advertising, packaging, and copy protection. 



About the Packaging 
Ultimate Solitaire doesn’t come in a box with fancy styrofoam stuffing or glow in the 
dark stickers. We did this on purpose. We hate excessive cardboard and styrofoam for 
environmental reasons. We have done our best to avoid putting anything in the package 
that you’ll just throw away. We like trees. Our package is just the right size and doesn’t 
require any popcorn or fluffy cardboard filler to make the box feel full.  

Here’s an experiment. Buy 10 Macintosh products. Count how many have a lot of filler 
making the box look bigger. See how much smaller the box could be if the goal was not 
just to have a bigger box. Call those companies and tell them to make their boxes smaller. 
See what they say. 



Suggested Reading 
These are a couple of books that don’t have anything to do with Macintosh software, or 
solitaire, or cards, or anything, but we always enjoy reading them. On top of that, they 
embody the Delta Tao philosophy. In the years we’ve been recommending these books, 
we’ve never heard a complaint that one wasn’t worthwhile. 

The Tao of Pooh, by Benjamin Hoff. The best book on Taoism ever.  

Calvin and Hobbes, by Bill Watterson.  

The Macintosh Way, by Guy Kawasaki. 

Surely You Must Be Joking, Mr. Feynman, by Richard Feynman. 

The Straight Dope, by Cecil Adams. 

Nobody’s Business if You Do, by Peter McWilliams. 

The Dilbert Principle, by Scott Adams. 



Delta Tao’s Other Games 
If you like Eric’s Ultimate Solitaire X (and we know you do), we hope you’ll try the 
other stuff we make — it’s cool, too.  

Spaceward Ho! 5 
Our “conquer the galaxy” game has earned critical raves and a fanatical following. If 
you’re interested at all in fun, fast strategic games, we recommend the Ho!. 

Strategic Conquest 4 
Explore the world and fight a mysterious enemy with a variety of military machinery, 
including aircraft carriers, bombers, armies, and so on.  

Clan Lord 
Clan Lord puts hundreds of players together in a fantasy world to battle monsters and 
have adventures. 

Eric’s Cascade 
(Alas, out of print.) Create gorgeous fountains and waterfalls, solve puzzles, and be 
mesmerized. 



The Fine Print 
We provide this software to you under a license.  

You can put Eric’s Ultimate Solitaire on your hard disk. Don’t copy and give 
it to your friends. Or enemies, either, for that matter, though it might addict 
them and cost them their jobs and family life. 

If for any reason you feel the performance of this software is unsatisfactory within the 
first 30 days after purchase, you may return it to the place you purchased it for a full 
refund. We tested Eric’s Ultimate Solitaire X under a variety of conditions, and we 
believe it performs satisfactorily and safely. However, no guarantee can be made that it 
will function on your machine. Especially if your machine is a toaster. 

Under no conditions will Delta Tao be responsible for damage to your computer system and/or person 
(including eyesight damage from playing Ultimate Solitaire all hours of the day and night), other than 
refunding the purchase price of the software, even if we’ve been advised of the possibility of such 
damage. 

Don’t sue us for any reason, or we’ll stop writing cool games and blame it all on you. 

Eric’s Ultimate Solitaire X™, Eric’s Ultimate Solitaire CD™, Ultimate™, and Ultimate Solitaire™ are trademarks of Delta Tao Software, Inc. Don’t make 
any other games that use our names. Many other things in this manual are trademarks, too. You’ll figure them out. 

Congratulations, you have discovered Secret Message #2. We knew somebody read this stuff. 


